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1 Using the NetBeans IDE 

In this chapter we will examine how to set up a new application program using the NetBeans 

Integrated Development Environment with the language Java.  We will create a simple program to 

display a picture, then allow the picture to be turned on or off by means of buttons. 

Start the NetBeans IDE software and select File from the main menu at the top of the screen.  Select 

New Project from the drop down list: 

 

 

 

 

 

 

 

 

 

 

 

Check that Java / Java Application is highlighted, then click the Next button: 
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In the window which now opens, you will be asked to give a name for the project you are creating.  

Use the project name: camera. 

You also need to choose a location where the project will be saved.  This can be on the computer 

hard disc or on a USB memory stick.  Use the Browse button to find the location. 

Finally, un-tick the box labelled Create Main Class.  We will not require this option.  

 

 

 

 

 

 

 

 

 

 

 

Click the Finish button to return to the main NetBeans page. 

Click the Projects tab at the left of the page, then right click on the Camera project icon to open a 

drop-down menu.  Select New, then JFrame Form: 
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We are now going to create a page which will appear when the program runs.   

In the section for Class Name, give the same name as the project.  This is camera. 

In the section for Package, give the project name followed immediately by the word Package. In this 

case, the name will be cameraPackage.  

 

 

 

 

 

 

 

 

 

Click the Finish button.  An empty rectangular form will be displayed, ready to create your page 

design. 

Click on the form and go to the Properties window at the bottom right of the screen.  Select the 

Code tab.  We are going to create some program code which will allow us to set the size of the 

window which will appear when the program runs. 

Select Generate pack(), then click the Generate Resize Code option: 
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After doing this, ticks should appear in the boxes labelled Generate Position and Generate Size: 

 

 

 

 

 

 

 

 

Test that the empty program has been created correctly by clicking the green Run arrow on the row 

of icons at the top of the NetBeans screen: 

 

 

 

 

 

 

 

 

 

A window will appear, asking you to confirm that you wish cameraPackage.camera to be the Main 

class.   Click the OK button to confirm this: 
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An empty program window should now appear. However, you will see that this is not displayed in 

the normal colour scheme used by other Windows applications.  We will now correct this. 

Close the program window and return to the NetBeans editing page.  Click the Source tab at the top 

left of the design window to open the program code. 

Look down through the program listing to find a section called main.  Inside this is a label saying 

‘Look and feel setting code’.  Click the + icon to open this option: 

 

 

 

 

 

 

 

 

 

 

Look for the line of code containing the word “Nimbus”, and replace this with “Windows”.    

 

 

 

 

 

 

 

 

 

The line should now read: 

                                  if ("Windows".equals(info.getName())) 

Run the program again, and the form should appear in the correct Windows colour scheme. 
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We have one final parameter to set before we begin to design the program.  Close the program form 

and return to the NetBeans design page.   Right-click on the form, then select Set Layout / Absolute 

Layout.  This will make it easy to drag and drop components into any position when creating the 

program screen. 

 

 

 

 

 

 

 

 

 

 

The steps which you carried out above are the standard sequence for setting up a new Windows 

graphical user interface project in NetBeans.  We will follow this sequence each time we create a 

new program, just changing the project name as required. 

 

We can now move on to create the actual program.  This will be show a picture of a camera, with 

buttons to allow the picture to be visible or hidden. 

We will begin by setting up another Package within the project which will provide a storage area for 

the picture.   Use the + icons to open the camera project folders until you reach cameraPackage.  

Right-click on cameraPackage, and select New / Java Package: 
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Whenever we use images in a project, we will create a package called resources into which they can 

be stored.  Set the Package Name to be cameraPackage.resources and click the Finish button.   

 

 

 

 

 

 

 

 

 

 

Return to the NetBeans design screen.  Locate the Label component in the Swing Controls section of 

the Palette on the right of the screen.  Drag and drop a label onto the form: 

 

 

 

 

 

 

 

 

 

 

 

Before continuing, obtain a JPG image of a camera.  Use a graphics application such as Paintshop 

or Paint to adjust the width of the image to approximately 250 pixels. 
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Click to select the label component on the form.  Select the Properties tab above the window at the 

bottom right of the screen, then locate the icon property.  Click the '…' (ellipsis) button.  A window 

opens, which will allow us to upload the camera picture to the project:   

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the Import to Project button, then use the file dialog to locate the picture. Click Next and select 

resources as the target folder, then click Finish.  After uploading, the file name should be displayed 

in the File text box: 
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Click the OK button to return to the NetBeans design screen.  The camera image should now appear, 

with label text shown alongside.  You may need to drag the image completely onto the form. 

Right-click on the image to open a drop-down menu.  Select Edit Text, then delete the label caption. 

 

 

 

 

 

 

 

 

 

 

 

 

We will now add a set of buttons.  Select the Button component from the Swing Controls section of 

the Palette, and drag and drop three buttons onto the form and arrange them above the picture.   

Right-click on each of the buttons in turn.  Select the Edit Text option from the drop-down menu, 

and give the buttons the captions: 

Show picture 

Hide picture 

Exit 
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Right-click again on each of the buttons, and this time select Change Variable Name. We will give 

the buttons names which clearly identify their purpose in the program.  This will make the program 

code easier to understand, with less chances of making mistakes. Give the buttons the names:  

btnShow 

btnHide 

btnExit 

Right-click on the camera picture and select Change Variable Name.  Give the name: 

lblPicture 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                        Chapter 1:  Using the NetBeans IDE         15 

 

We can now add program code to make the picture appear and disappear.   

Double-click the Show picture button.  The program code window will open, and you will notice that 

an empty method has been created.  This contains a comment in pale grey:  

                                                 // TO DO add your handling code here: 

This comment line can be deleted and replaced by your own program code.  Any commands which 

you write inside this method will be carried out when the program is running and the button is 

clicked. Add the line of code: 

                                   lblPicture.setVisible(true); 

 

 

 

 

Click the Design tab to return to the program form, then double click the Hide picture button: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

An empty method will again be created.  This time, add the line of program code: 

                                                                lblPicture.setVisible(false); 

The two buttons will be able to change the visible property of the picture while the program is 

running. 
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Finally, double click the Exit button and add a line of code to close the program: 

                                                       System.exit(0); 

The program code should now contain the three completed button-click methods: 

 

 

 

 

 

 

 

 

Run the program by clicking the green Run arrow on the row of icons at the top of the NetBeans 

screen.  The camera picture can be hidden or displayed by means of the buttons.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Check that the Exit button closes the program window correctly. 
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For the next program, we will create a screen for display in a Job Centre which will illustrate the 

types of work currently available.  The program will provide buttons to allow the staff to switch 

pictures on or off, according to the current job vacancies. 

 

 

 

 

 

 

 

 

 

Select the NetBeans File menu and click the option to Close All Projects: 

 

 

 

 

 

 

 

 

From the File menu, select New Project, and check that Java / Java Application is highlighted. 

Give the Project Name as JobCentre, and un-tick the Create Main Class option: 

 

 

 

 

 

 

 

  



18         Java Programming for A-level Computer Science 

 

Click Finish to return to the main NetBeans editor.   

Right click the jobCentre project icon, then select New / JFrame form from the drop-down menus:  

 

 

 

 

 

 

 

 

 

 

Enter jobcentre as the Class Name, and jobCentrePackage as the Package: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the Finish button to return to the editor screen. 
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This program will again make use of picture images, so we will create a resources folder into which 

these can be stored. 

Use the + icons to open the jobcentre project folders, until jobCentrePackage is reached.  Right-click 

jobCentrePackage and select New / Java Package from the drop-down menus:  

 

 

 

 

 

 

 

 

 

 

 

 

Give the package name as jobCentrePackage.resources 

 

 

 

 

 

 

 

 

 

 

Click the Finish button to return to the editing screen. 

A blank form should be displayed, ready to begin the program design. 
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Drag a label onto the form.  You will see grey bars attached to the label component.  These are part 

of a system for aligning components to create input forms, and will not be required in our program.  

We will turn these off now.   

Right-click on the form, then select Set Layout / Absolute Layout from the drop-down menus.  

 

 

 

 

 

 

 

Right-click on the label, then use the Change Variable Name option to reset the label name to: 

                                                                          lblJob1 

 

 

 

 

 

 

 

 

 

 

 

Before continuing with the program, obtain JPG images representing four different jobs, for 

example: 

   Carpentry  

                                           Catering  

   Office work  

                                           Bar work 

Use a graphics editor such as Photoshop or Paint to adjust the width of each image to 

approximately 150 pixels. 
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Select the label which you placed on the form, and go to the Properties window at the bottom right 

of the screen.  Find the icon property, and click the “…” ellipsis symbol at the end of the line: 

Use the Import to Project option to upload the four images to the resources folder. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select one of the images as the File to be displayed, then click the 'OK' button to return to the 

NetBeans editing screen. 

Right-click on the image and use the Edit Text option to delete the label text. 
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Add three more labels to the form, dragging the form wider if necessary.  Change the names of these 

labels to: 

                                                        lblJob2 

 lblJob3 

 lblJob4 

 

 

 

 

 

 

 

 

 

 

Set the icon property of each label to display a picture image.  Notice that the JPG images which you 

uploaded earlier are now available from a drop-down list on the icon property line: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Right-click on each of the images and use the Edit Text option to delete the label text. 
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The final stage of the program is to provide buttons to show or hide the picture images.  Rather than 

use two separate buttons for each picture, as we did with the camera program earlier, it is neater to 

use Toggle Buttons.  A toggle button has two states – selected and unselected.  It changes between 

states each time it is clicked. 

Drag a Toggle Button from the Palette and position it below the first image: 

 

 

 

 

 

 

 

 

Change the name of the toggle button to: 

    btnJob1 
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In order to use the toggle button, the program will need an additional code module.  Use the Source 

tab above the design form to change to the program code page.  Add a line of code:    

                       import javax.swing.JToggleButton; 

just after the start of the program, in the position shown below: 

 

package jobCentrePackage; 
 
import javax.swing.JToggleButton; 
 
public class jobCentre extends javax.swing.JFrame { 
    
    public jobCentre() { 
        initComponents(); 
    } 

 

Click the Design tab to return to the design view, then double click the toggle button which you 

placed on the form.  The program will change to the code page and you will see that an empty 

button click method has been created.  Add the lines of program code shown below: 

 

private void btnJob1ActionPerformed(java.awt.event.ActionEvent evt) {                                         
        
        JToggleButton btn = (JToggleButton) evt.getSource();  
        if (btn.isSelected()) 
        {  
            lblJob1.setVisible(true); 
            btnJob1.setText("off"); 
        }  
        else 
        {  
            lblJob1.setVisible(false);  
            btnJob1.setText("on"); 
        } 
 
    }      
 
 
 
 
 
 

The purpose of this code is to check whether the toggle button is currently in its selected or 
unselected state.  Depending on the result, it will display or hide the picture image by 
changing the visible property of the label component.  The caption on the toggle button will 
also be changed to either “on” or “off”.   
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Click the green Run arrow.  Click OK to confirm that you want jobCentrePackage.jobCentre to 
provide the main class for the project:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The program should display the images, but the normal Windows colour scheme is not used and the 
form is not set to the correct window size.  We will correct these problems now. 
 
Close the program window to return to the NetBeans editing screen.  Click the Source tab to select 
the program code, then locate the main method. 
 
Open the method code by clicking the + icon, then change the word “Nimbus” to “Windows” on the 
line shown below: 

 
 
 
 
 
   public static void main(String args[]) { 
        
        try { 
            for (javax.swing.UIManager.LookAndFeelInfo info :  
              javax.swing.UIManager.getInstalledLookAndFeels()) { 
 
                if ("Windows".equals(info.getName())) { 
 
                    javax.swing.UIManager.setLookAndFeel(info.getClassName()); 
                    break; 
                } 
            } 
        } catch (ClassNotFoundException ex) { 
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Return to the Design view and click on an empty area of the form to select this component.   

Click the Code tab in the Properties window, then go to the Form Size Policy line.   

Click the Generate pack() option, and select Generate Resize Code from the drop-down list: 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Return to the toggle button and right click to open the drop-down list.  Use the Edit Text option to 

set the button caption to the word ‘off ’ :      
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                        Chapter 1:  Using the NetBeans IDE         27 

 

Go to the Properties window and find the selected property for the toggle button.  Put a tick in the 

tick-box column:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Run the program again.  The window should now be the correct size, and displayed with the correct 
colour scheme.  The toggle button will show the caption 'off'. 

Check that the picture image can be hidden or displayed by repeatedly clicking the toggle button, 
and that the button caption changes correctly with each mouse click. 

 

As a challenge, complete the programming for the remaining three images.   

 Add toggle buttons 

 Create button click methods 

 Add program code to make the image visible or hidden. 

Remember to change the variable names for each of the images in turn.  For example, the button 
click method for the second picture image should be: 

 

private void btnJob2ActionPerformed(java.awt.event.ActionEvent evt) {                                         
        
        JToggleButton btn = (JToggleButton) evt.getSource();  
        if (btn.isSelected()) 
        {  
            lblJob2.setVisible(true); 
            btnJob2.setText("off"); 
        }  
        else 
        {  
            lblJob2.setVisible(false);  
            btnJob2.setText("on"); 
        } 
 
    }      
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Test your completed program to check that each of the picture images can be displayed or hidden 

correctly: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


